Answer Key o’

Part-A: Employability Skills

n Introduction to Communication

Unit 1: Communication Skills-I

ACTIVITY Page 22

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. ii. Simple words
2. lii. Feedback
B. 1. Decoding
2. Sender

Section B (Subjective Type Questions)
A. 1. Itisthe process of conveying information, ideas or feelings through language or other means.

Communication skills are required for the effective interaction, building relationships,
expressing matters clearly and understanding others.

2. Sender: The person who starts the communication and encodes the message.
Message: The information or ideas being conveyed.
Receiver: The person who receives and decodes the message.

B. She is providing of both verbal and non-verbal communication to confirm her understanding
the message and acknowledge the request.
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mVLbal Communication

Unsolved Exercise @

Unit 1: Communication Skills-1

Section A (Objective Type Questions)

A. 1. ii. Preparation
2. ii. Confidence
B. 1. True
2. True

Section B (Subjective Type Questions)

A. 1. Oral or spoken communication: This is established through telephonic conversation,
face-to-face conversation, etc.

Written communication: This is established using written or typed message in the form of
an e-mail, SMS or any other format including photos, videos, music, etc.

2. The three key elements to overcome anxiety and be an effective speaker are:

Prepare: Make the content interesting and engaging to capture your audience’s attention
and earn their praise.

Practice: Rehearse the delivery of your speech to build confidence. Focus on the voice
modulation and body movements hand gestures and practice pausing and breathing.

Perform: Preparation and practice you have attended half success. Stay confident and manage
your nerves to deliver a powerful performance.

B. Ravi must follow the following steps:

« Know the audience.

« Prepare accordingly.
 Practice delivery.

« Engage the audience.

Non-Verbal Communication Unit 1: Communication Skills-I

ACTIVITY Page 31

Do it yourself.

Unsolved Exercise .

Section A (Objective Type Questions)
A. 1. i. Putting an arm around a co-worker's shoulder.
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i. Non-Verbal
iv. All of these
Facial expression
Gestures

Section B (Subjective Type Questions)
Four common signs used for visual communication include:
Traffic light: Indicates the presence of a traffic signal ahead.
Stop: Indicate to stop.
No smoking: Indicate that smoking is prohibited at that place.
Railway Crossing Ahead: Warns of a railway crossing ahead.
Importance of non-verbal and visual communication are:
« Enhance the understanding and reaches the receiver fast.
« Overcome the language barriers.
« Convey emotions.

« Provide clarity.

B. The sign indicates that the entry is prohibited without the permission of the land owner.

mw Ski“s: Parts Of Speech Unit 1: Communication Skills-I

Unsolved Exercise @

A.

N = N =

Section A (Objective Type Questions)
iii. Question Mark

i. I met Mrs. Sharma yesterday
False
True
Section B (Subjective Type Questions)
The writing skills are abilities that allow individuals to convey message effectively through
the written word. They includes various aspects like grammar, vocabulary and clarity. Strong

writing skills are essential for academic, professional, legal and personal communication and
documentation.

Parts of speech are the categories of words based on their functions in a sentence formation.
The eight parts of speech in English grammar are:

Noun: The words that represents a person, place, thing or idea.
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Pronoun: The words that are used in place of nouns to avoid the repetition of noun.
Verb: The words that shows action.

Adverb: The words that modifies the verb or adjectives.

Adjective: The words that describes a noun or pronoun.

Preposition: It is used to connect one word with another word to show relationship between them.
Conjunction: It is used to join two nouns, phrases or sentences.

Interjection: It express strong emotions or sudden reactions, such as happiness, surprise,
excitement and anger.

3. Conjunction: And, Or
Preposition: Under, In, At, Up
B. Raj should use an exclamation mark (!) and comma (,) and correct capitalisation.

Wow! That's amazing, Neha.

writing Ski“S: Sentences Unit 1: Communication Skills-I

Unsolved Exercise ‘

Section A (Objective Type Questions)

A. 1. iii. To whom or for whom
2. iii. Me

B. 1. False
2. True

Section B (Subjective Type Questions)
A. 1. The water is clean.

Dogs are pet animal.

2. A paragraph is constructed with a topic sentence, supporting sentences and a concluding
sentence. The topic sentence introduces the main idea, supporting sentences provide details
and evidence and the concluding sentence summarises the main points. A paragraph focuses
on a single.

Rules for writing a paragraph:
+ Begin each paragraph on a new line.
 Indent the first line of the paragraph.
« Focus on a single main theme or idea.
B. Passive Voice
£
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PronunCiation BaSiCS Unit 1: Communication Skills-I

Unsolved Exercise @

A. 1.
2.
1
2

Section A (Objective Type Questions)
iii. Consonant

iii. Cake

. Consonant

. long vowel

Section B (Subjective Type Questions)
Phonetics is the study of the sounds we make when we speak.

Vowel: The English alphabet has five vowels (a, €, i, 0, u), but 12 vowel sounds. Each vowel
can be pronounced differently.

Consonants: Any sound that is neither a vowel nor a diphthong.

B. The English alphabet has 26 letters, but each letter can be pronounced in different ways in
different words. We use more than 26 sounds when speaking English, which is why spelling and
pronunciation often do not match.

Greeting and IntrOduction Unit 1: Communication SKills-I

Unsolved Exercise @

A. 1.
2.

Section A (Objective Type Questions)
ii. To start a conversation

iii. Hey there!
i. I'm well, thank you. How about you?
Section B (Subjective Type Questions)

Greeting are the expressions used to acknowledge someone’s presence using specific words
and phrases based on the context and relationship with people involved.

Introduction is to present individuals to each other, establish initial contact and facilitate
further interaction or conversation for personal or professional interest.

Formal greeting are used in professional settings or when addressing people you do not
know well, such as in workplaces, schools or with elders.

Informal greeting are used in casual settings with friends, family or familiar individuals.

Y

DI2OIIIPPP000) Toucpad I 402 Vs, 40) X (rer K9 5



B. 1. Rina could say ‘Good morning, Sir'.

2. Mabhi could say 'Hello, Shyam, welcome to the team, I'm Mahi.’

ml“(ing About Self Unit I: Communication Skills-I

Unsolved Exercise @

Section A (Objective Type Questions)
A. 1. ii. Saying your name

2. ii. Your full postal address

3. i. Name

Section B (Subjective Type Questions)

A. 1. Noun in an introduction are the words that represent people, place, thing or ideas. For
example, Satya, Mumbai, Ball and painting.

2. Some common fields found in a form are:
« Name: first name, middle name, last name.
« Date of Birth: Format is Day-Month-Year.
« Address: House number, Street name, Locality, City and Pin code.
« Gender: Whether Male or Female.
« Phone number.
+ Signature: Your handwritten name or initial.
B. The following are the key details that are included while introduction to a new person:
e Full name.
* Your occupation.
« Your current address.

* Your purpose of being there.

ASking Questions I Unit 1: Communication Skills-I

Unsolved Exercise .

Section A (Objective Type Questions)
A. 1. i Who, Where, When, What, Why, How

2. iii. When
3. ii. To gain information and clarify doubts
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Section B (Subjective Type Questions)
A. 1. How do you go to that unknown place?

2. Where

3. To get information and details about a thing, idea or action.

ASking Questions II Unit I: Communication Skills-I

Unsolved Exercise @

Section A (Objective Type Questions)
A. 1. ii. Close-ended

2. ii. Why
3. ii Open-ended and Close-ended
Section B (Subjective Type Questions)
A. 1. Anexample of open-ended question:
‘Why are you late today?’

2. Open-ended questions require more detailed answers and cannot be answered with just
‘'yes' or 'no’. They are used for elaborated information.

Close-ended questions can be answered with a simple 'yes' or 'no’ or another limited set of
responses. They are used for specific, concise information.

n Introduction to Self-Management

Unit 2: Self-Management Skills-I

ACTIVITY Page 53

Do it yourself.

Unsolved Exercise .

Section A (Objective Type Questions)
A. 1. iv. Self management

2. i. Self-control

B. 1. False
2. False
3. True
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Section B (Subjective Type Questions)
A. 1. Goal setting skill the ability to define clear, specific and achievable objectives. It provides
direction and motivation, helping you to measure progress and stay focused on your desired
outcomes.

2. i. Self-Control: It is the ability to manage our emotions, impulses and behaviours effectively,
especially in a challenging situations.

ii. Positive Thinking: It is the practice of focusing on the good in any given situation and
maintaining an optimistic outlook.

B. 1. The advice that he should follow are:
 Create a daily work schedule and remain stick to it.
« Focus and prioritize the most important task first.
 Divide the large complicated projects into smaller manageable steps.
+ Keep the working environment distraction free.
2. Rohan should focus on:
 Plan the routine in advance and select the outfits accordingly.
« Maintain personal hygiene.

 Dressing should match the working environment and your professional look.

m Strength and Weakness Analysis

unit 2: Self-Management SkKills-I

ACTIVITY Page 56
Do it yourself.
Unsolved Exercise @

Section A (Objective Type Questions)
A. 1. ii. Alack of patience

2. ii. Achieving personal and professional goals

B. 1. True
2. True
3. False

Section B (Subjective Type Questions)
A. 1. Itisimportant to know yourself because:
« It allows you to understand your strengths and weaknesses.
+ It helps in improving your personal and professional relationships.
P
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Some important points that help you to know yourself are:
« Seek feedback from others about your change.
« Analyse your past and present experiences.
2. One can improve weakness by:
+ Identifying them.
« Setting specific and achievable goals for improvement.
« Seeking guidance or training.
 Practicing consistently and monitoring progress.
B. Aman can be helped for better time management skills by the following techniques:
+ Creating schedule.
* Prioritizing tasks.
» Breaking large tasks into smaller ones.
+ Setting deadlines.

* Minimising distractions.

Self'confidence Unit 2: Self-Management Skills-I

Unsolved Exercise @

Section A (Objective Type Questions)
A. 1. iv. All of these

2. ii. Positive attitude

3. ii. Set clear, achievable goals
B. 1. True

2. False

3. True

Section B (Subjective Type Questions)
A. 1. Two factors that can decrease self-confidence are:
« Low self-esteem.
 Fear of failure.
2. The role of physical factors in self-confidence are:
 Physical health and appearance increases self-confidence.

+ Feeling healthy and comfortable in one’s body can boost self-esteem.
« Negative health issues or body image can decrease self-confidence.
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3. Staying happy with small things make a positive mindset and enhance self-esteem and
boosts self-confidence.

B. As a colleague Sarah is advised to consider the following strategies:
 She should begin by sharing small contributions or giving brief comments.
 Practice positive self-talk and remind her of her talent and values.
« Encourage her to focus on the value her ideas bring to the team rather, criticizing them.
+ She should take feedback from trusted colleagues and mentors after meeting.
+ Celebrate her successes, no matter how small it is.
Examples:
« She may prepare presentation in support her ideas during meetings.

« The presentation may be displayed before her colleagues beforehand.

+ She could focus on how her idea benefits to achieve the goal.

POSitive Thinking Unit 2: Self-Management Skills-I

ACTIVITY Page 65
Do it yourself.
Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. iii. Imagine the Best in Any Situation

2. iv. Rahul learns from the feedback and makes his project work better
B. 1. False

2. True

Section B (Subjective Type Questions)
A. 1. Positive thinking enhances interpersonal relationships by fostering a more supportive and
encouraging environment. Optimistic individuals are more likely to build strong, healthy
relationships and handle conflicts more effectively.

2. A positive thinking enhances motivation and goal setting. When individuals believe in their
ability to succeed and remain optimistic about their efforts, they are more likely to persist
in their pursuits and achieve their goals.

Swati can use the imagine the best in any situation strategy from the SMILE acronym.
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Personal Hygiene Unit 2: Self-Management Skills-I

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. ii. Every day

2. ii. Wash your hands

3. iv. Rubbing oil/cream for skin care
B. 1. True

2. True

3. False

Section B (Subjective Type Questions)
A. 1. The three things you should follow for personal grooming are:

« Brush teeth twice a day
+ Take bath everyday
« Comb the hair regularly

2. To avoid spreading germs when coughing or sneezing:
« Cover mouth and nose with a handkerchief.
B. Swati can follow the following steps to ensure effective hand washing:
Step 1: Wet her hands with clean water.
Step 2: Apply soap to cover her hands, between the fingers and under the nails.
Step 3: Scrub the hands for 20-25 seconds.
Step 4: Rinse hands with running water.

Step 5: Dry the hands using a clean towel.

mﬂaoming Unit 2: Self-Management Skills-I

ACTIVITY Page 70
Do it yourself.
Unsolved Exercise @

Section A (Objective Type Questions)
A. 1. iii. Twice a day
=
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2. ii. Simple and well-combed hair
B. 1. True
2. False

Section B (Subjective Type Questions)

A. 1. Grooming contributes to confidence by ensuring a person feel presentable. It puts a positive
impact on their self-esteem, make them more comfortable and confident in the society and
the professional settings.

2. Simple accessories are recommended because they enhances our outfit and add a touch of
personality and style to our professional look.

B. He can use a small amount of hair product or if time permits he may dampen his hair slightly
to insure proper combing to ensure his grooming is up to standard.

mﬂoduction to ICT Unit 3: ICT Skills-1

Unsolved Exercise @
Section A (Objective Type Questions)
A. 1. ii. Monitoring
2. ii. To improve business operations
Section B (Subjective Type Questions)
A. 1. Two uses of ICT at home are:
+ Online shopping.
« Home automation (Smart home devices).
2. Some benefits of using ICT in daily life for convenience and connectivity are:
+ Faster communication via e-mails and messaging apps.
 Easy access to information through the Internet.
B. ICT can help the student in the following ways:
« Through online learning platforms: Online courses, video lectures.
« Virtual tutorials can connect with teachers or other students for online help and discussions.

« By downloading resources and educational apps if the internet connectivity is limited.

o)
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m ICT Tools: Smartphones and Tablets—I

unit 3: ICT Skills-I

ACTIVITY Page 78

Do it yourself.

Unsolved Exercise @

Section A (Objective Type Questions)
A. 1. ii.Radio

2. ii. Clock
3. ii. Web Browser
Section B (Subjective Type Questions)

A. 1. Ane-mailisan electronic method of sending and receiving messages, documents, and other
media over the Internet.

2. i. Phone ii. Calendar iii. Gmail iv. Camera

B. The ICT tool that will be most suitable for Maya is a Tablet.

m ICT Tools: Smartphones and Tablets—II

unit 3: ICT Skills-1

Unsolved Exercise @

Section A (Objective Type Questions)
A. 1. ii Tracking movements and navigation.

2. iii. Pinch
Section B (Subjective Type Questions)

A. 1. The feature that allows a mobile device to connect to the Internet without physical cables
is Wi-Fi (Wireless Fidelity).

2. The home button is used to return to the main screen of the device.

B. The gesture to reposition the app icon is ‘drag and drop’. To do so, tap and hold the app icon
and drag it to the desired location on the screen before releasing.
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m Parts of a Computer and Peripherals

Unit 3: ICT SkKills-I

Unsolved Exercise @

A.

)
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Touchpad IT 402 (Ver. 4.0)-1X (Answer Key)

Section A (Objective Type Questions)
i. Accelerated Graphics Port

ii. Playing games

iii. Dots per inch

iii. 1024 megabytes

ii. Light Pen

Memory Card

Switch Mode Power Supply (SMPS)
High-Definition Multimedia Interface (HDMI)
Memory Unit

Section B (Subjective Type Questions)

A computer is an electronic device that can perform calculations, store data and execute
instructions. It is a versatile machine used for a wide range of tasks, from simple calculations
to complex simulations.

BIOS (Basic input/Output System) is a firmware that is embedded on a computer’s
motherboard. It initialises and tests the system hardware components when the computer
is turned ON, and loads the operating system. It also supports the transfer of data among
the hardware devices.

i. Smartphone and Tablet: A smartphone is a mobile phone with advanced computing
capabilities and connectivity, while a tablet is a portable computer with a touchscreen
interface, typically larger then a smartphone.

ii. Printer and Plotter: A printer produces text and graphics on paper, while a plotter
is designed to create large-format drawings and designs, used in engineering and
architecture.

iii. RJ-11 and RJ-45: RJ-11 is a connector used for telephone lines, while RJ-45 is a connector
used for Ethernet network connection.

i. Processor: The processor or CPU, is the brain of the computer. It executes instructions
and perform calculations.

ii. Flash Flash Memory: Flash memory is a type of non-volatile storage used in USB drives
and memory cards. It can be electrically erased and reprogrammed.
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iii. Joystick: A joystick is an input device used for controlling movements in video games and
other games.

iv. Blu-ray Disc: A Blu-ray Disc is a high-capacity optical disc used for storing HD video and
large amounts of data.

B. 1. Ravishould use an external hard drive or a large capacity USB flash drive.

2. Priya should choose a plotter.

Basic Computer Operations Unit 3: ICT SKills-

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. ii. Deletes the character to the right of the cursor
2. iii. Symbian
3. iii. GNU-Linux
4. ii. Easier to use and understand
5. iii. Customised Software
B. 1. GUI (Graphics User Interface)
2. Special
C. 1. False
2. True
3. True

Section B (Subjective Type Questions)

A. 1. Anoperating system is a software that manages computer hardware and software resources. It
provides an interface for users to interact with the computer and allows different applications
to run. It also helps in process management, memory management, file system management
and input/output management.

2. The different types of keys on the keyboard includes:

+ Alphanumeric keys: It contains letters from (A to Z or a to z) for entering textual data.

« Numeric keys: Numbers from (0 to 9) for entering different types of numeric values. It
also have mathematical operators also.

+ Function keys: These keys from (F1 to F12) performs specific function depending on the
software in which its is being used.

« Punctuation keys: It includes keys for punctuation marks, such as colon (;), semicolon (;),
question mark(?), single quotation mark (' '), double quotation mark (" “), etc.
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+ Control keys: Keys such as control (Ctrl), Shift, Spacebar, Alt, Caps lock and Tab are special
control keys that perform specific functions depending on when and where they are used.

« Navigation keys: The keys ( Arrow, Home, End, page UP, Page Down) are used for moving
the cursor.

« Command keys: Keys such as Insert, Delete, Backspace and Enter are command keys.

+ Enter key: This key is labelled as Return key. It helps to send the cursor to the next line
and is also used to execute a command.

« Windows key: Pressing the Windows key on the keyboard the Start menu get activated.

3. i. Windows OS: It is a widely used operating system developed by Microsoft, known for
its user-friendly interface and compatibility with a wide range of software and hardware
devices.

ii. Device Driver:Itis a software program that enables the operating system to communicate
with a specific hardware device.

B. 1. The multitasking GUI feature allows Avinash to work on a presentation and listen to music
simultaneously.

2. Thedrag and drop method would be most suitable for Aman to visually see the folder being
placed in the location.

m Performing Basic File Operations Unit 3: CT Skills-|
'Ab AssiGNMENT ‘N ACTiViTy Page 107

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. i .txt 2. ii. Music file
3. i. Rightclick, select New, then select Folder 4. i. .png
5. iii. Enter 6. ii. A container for storing files
7. i. Right-click the folder and select Rename

B. 1. Spreadsheet

2. File management

Section B (Subjective Type Questions)
The default name of a newly created folder in Windows is ‘New folder’. It can be renamed

by right-clicking on the folder and selecting ‘'Rename’ option and typing the new name and
press the enter key.
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2. The steps to create a new file:
Step 1: Right-click in the location where the file needs to be created.
Step 2: Hover mouse over ‘New’ in the content menu.
Step 3: Select the desired file type (e.g. Text Document, Word Document or Excel Worksheet).
Step 4: A new file with a default name will appear.
Step 5: Right-click on the new file, select 'Rename’ and type the desired name.
Step 6: Press the Enter key.

B. To create subfolders within a ‘School’ folder, Priya can follow these steps:

Step 1: Open File Explorer.

Step 2: Navigate to the ‘'School’ folder.

Step 3: Right-click within the 'School’ folder.

Step 4: Select 'New’ from the context menu.

Step 5: Choose ‘Folder'.

Step 6: Type ‘Math’ as the new folder name and press Enter key.

Step 7: Repeat the above steps to create ‘Science’ and ‘History’ subfolders.

So Priya has got three subfolders with name ‘Math’, ‘Science’ and 'History’ within the main folder
‘School'.

Communication and Networking—Basics of
Internet

Unit 3: ICT Skills-1

Unsolved Exercise @

Section A (Objective Type Questions)

A. ii. 1,000 kilobits per second

—_

ii. Ethernet cable
iii. Snapdeal

ii. Access and navigate websites

AR

iii. Hertz

Section B (Subjective Type Questions)
A. 1. The amount of data that can be transferred over a network connection in a given amount
of time is termed as bandwidth. It is measured in bits per second (bps) or its multiples,
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such as kilobits per second (Kbps) or megabits per second (Mbps) and gigabits per second
(Gbps).

Internet plays a major role in travel by providing access to information related to booking
services, navigation tools etc. It allows to research on destinations, compare prices, book
tickets and accommodations, access to maps and directions and stay connected to others
while travelling.

B. The factors Arjun should consider while choosing wired or wireless connections are:

Speed: Wired connection generally provide higher speed and more stable connection.
Reliability: Wired connection provide reliable connection.

Mobility: Wireless connections offer greater mobility while staying connected.
Security: Wired connections are generally more secure than wireless connections.

Cost: The installation and maintenance cost of wired connection is more as compared to
wireless connections.

Communication and Networking—Internet
Browsing

Unit 3: ICT Skills-I

Unsolved Exercise .

A. 1.

o)
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Section A (Objective Type Questions)
ii. To translate domain names into IP addresses

ii. To link web pages
iii. HTTPS
ii. A document accessed via a browser
ii. HTML
Section B (Subjective Type Questions)

An absolute URL are the URL's with a complete Internet address specifying the location of
a resource (including the protocol, domain name, and path).

A relative URL specifies the location of a resource relative to the current location. It is used
to refer to links on the same server as the page that contains them.

HTTPS (Hypertext Transfer Protocol Secure) encrypts communication between a user's
browser and a web server, protecting sensitive data from being intercepted.

Web servers are computers that deliver web pages to users on getting request from the web
browser.

The two types of URL's are — Absolute and relative URL.
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An absolute URL are the URL's with a complete Internet address specifying the location of
a resource (including the protocol, domain name, and path).

Example: https://www.micaeduco.com/about.htm

A relative URL specifies the location of a resource relative to the current location. It is used
to refer to links on the same server as the page that contains them.

Example: www.micaeduco.com

Protocols are set of rules that governs how data is transmitted and received over a network.
Example: HTTP (Hypertext Transfer Protocol), FTP (file Transfer Protocol), etc.

B. Ravi should look for HTTPS protocol in the website’'s address to ensure his data is secure.

Communication and Networking—
Introduction to e-Mail

Unit 3: ICT Skills-I

Unsolved Exercise .

A. 1.

vk W

Section A (Objective Type Questions)
i. @
ii. E-mail Service Provider
ii. Instant delivery
ii. Both have specific senders and receivers
ii. Can get spammed
Section B (Subjective Type Questions)
An e-mail is a method of exchanging digital messages over the internet. It is fast, convenient

and cost-effective way to communicate with individuals, groups. It helps in sharing text,
images or any attachments.

Limitations of e-mail:

¢ Overload may delay the mail causing late delivery.

 Risk of viruses, phishing and spam.

 Lack of nonverbal cues can lead to misinterpretations.

« Dependency on internet access.

Two kinds of e-mail services:

« Webmail: Accessible through a web browser (e.g. Gmail, Yahoo Mail)

« E-mail client: Requires a software application (e.g. Microsoft Outlook, Mozilla Thunderbird)
Fi
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4. Two parts of an e-mail address are:

« Username: The unique identifier before the ‘@’ symbol.

« Domain name: The part after the ‘@' symbol, indicates the e-mail service provider or
organisation.

B. The action company should take are:

Implement a backup e-mail system or service to ensure communication continuity.
Must keep an alternative communication methods for the employees and stakeholders.

Must have a plan to restore the system as soon as the network is back, to ensure minimum
data loss.

Use cloud based e-mail services that are less susceptible to local network outages.

m Communication and Networking—Creating

an e-Mail Account

Unit 3: ICT Skills-I

Unsolved Exercise @

A.

A.

1.
2.

1.

Section A (Objective Type Questions)
ii. To make the password stronger and more secure
iii. 6 digits
Section B (Subjective Type Questions)
Steps to create an e-mail ID:
Step 1: Open a web browser.
Step 2: Click on 'Sign up’ or ‘Create account'.
Step 3: Fill the required informations, desired username and password.
Step 4: Agree to the terms of service and privacy policy.
Step 5: Complete the verification steps, such as CAPTCHA code, phone or e-mail address.
Step 6: Click on I agree button.

Your email account gets created.

2. The types of accounts that can be made when creating an e-mail ID using an web browser:

« Personal account
« Business account

B. To make her password secure Ashiya should include the following character combination:

Uppercase and lowercase letters.

Numbers.

+ Symbols like! @ # § % " & *.
Foal
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¢ The password should be at least 12 character long and not easily guessable(For example,
P@sswOrd#2025).

Communication and Networking—Writing
m an e-Mail

Unit 3: ICT SkKills-I

Unsolved Exercise .

Section A (Objective Type Questions)
A. 1. i. Attachment

2. ii. Sent
B. 1. Trash folder
2. 25MB
Section B (Subjective Type Questions)
A. 1. Attaching a file means sending a text document, spreadsheet file or image along with your

e-mail. Suppose you want to send the recent photos of the annual day function of your
school to your friend, you can send them as an attachment with the e-mail.

2. Four folders present in Gmail are:
Inbox, Sent, Draft and Trash.

B. Shivam can send Word document, Excel worksheet, Image files of recent family picnic etc,, to
his sister in Australia, through e-mail.

Communication and Networking—Receiving
m and Replying to e-mails

Unit 3: ICT Skills-1

'.Ab AssiGNMENT ‘N ACTIiViTy Page 136

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. ii. Bold
2. iii. Delete
B. 1. True
2. False
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Section B (Subjective Type Questions)

A. 1. Forwarding an e-mail means sending a copy of the e-mail you have received to another
recipients.

2. Steps to reply an e-mail:
Step 1: Open the e-mail you want to reply to.
Step 2: Click on 'Reply’ button.
Step 3: Type the message in the e-mail body.
Step 4: Click on the ‘'Send’ button to reply the e-mail.

B. By default, Sarah will receive the e-mail in the ‘Inbox’ folder of her e-mail ID.

What iS Entrepreneurship? Unit 4: Entrepreneurial Skills-I

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. ii. They are visionaries who identify market gaps and societal needs
2. ii. To achieve goals and serve customers well
3. iii. Growing the business
4. iii. Sticking to the same old ideas
B. 1. True
2. False

Section B (Subjective Type Questions)
A. 1. Entrepreneurs are special because they are visionaries who identify market gaps and societal
need, and take risks to create innovative solutions. They contribute to the society by creating
jobs, developing new products and services and contribute a lot in the economic growth of
the society and the country.

2. Planning and using the resources wisely is very important for the success of an enterprise.
It helps to attend the goal and ensure sustainability. Effective planning involves:
« Setting up objectives.
- Developing strategies.
« Making decisions about resource allocation.
« Serving the customers.

B. Aliya is demonstrating the start of a business stage of entrepreneurship as she is recognizing
an opportunity to sell her crochet sweaters based on the admiration of others.

£
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Role of Entrepreneurship Unit 4: Entrepreneurial Skils-I

Unsolved Exercise .

A. 1.
2.
B. 1
2.
A. 1
2.

Section A (Objective Type Questions)
ii. It creates more tasks and job opportunities, improving income and quality of life

ii. By developing affordable solutions that address basic needs, such as clean water
Small scale

Ideas and technologies

Section B (Subjective Type Questions)
Entrepreneurship helps in making products more affordable for everyone through competition,
new ideas, innovations, cost-effectiveness and wider range of options for consumers.

Entrepreneurship contribute significantly to economic growth by:

 Introducing new products and services that meet customers needs.

 Increasing the productivity.

 Attracting investments from individuals giving profitable returns.

+ Creating jobs.

« Social development by removing social problems and enhancing living standards.

B. Aman’s tutorial service is an example how entrepreneurship can contribute to the community
growth and development by providing education opportunities, creating jobs and solving specific
needs of the local area.

m Qualities of a Successful Entrepreneur

Unit 4: Entrepreneurial Skills-I

Unsolved Exercise .

A. 1.

Section A (Objective Type Questions)
iii. Only running their business to earn a steady income and not interested in new ideas or risks

iv. Confidence
True

False

Section B (Subjective Type Questions)
Creativity and innovation are very important for an entrepreneur’s success as they enable the
development of unique products and services, efficient problem solving and had the ability
P9
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to adapt changes according to the market requirements. For example of an entrepreneur
who was creative and innovative was Motorola engineer Martin Cooper, who revolutionized
the technological invention by developing mobile phone.

i. Hardwork and Perseverance: It is very essential for an entrepreneur to overcome obstacles,
manage challenges and stay committed to their goals, especially when facing setbacks.

ii. Openness to Trial and Error: It allow entrepreneurs to learn from failures, adapt
theirstrategies and continuously improve their ventures. It make positive mindset to
encourage innovations.

B. Priya is demonstrating perseverance by continuing to improve her products and remaining
hopeful as she knows that building a business takes time and patience.

Distinguishing Characteristics of
n Entrepreneurship and Wage Employment

Unit 4: Entrepreneurial Skills-I

ACTIVITY = Page 155

Do it yourself.

Unsolved Exercise @

A.

—_

w N

f)
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Section A (Objective Type Questions)
iv. Inadequate Planning

ii. Take calculated risks, learn from challenges, and keep working towards their goals
iii. Job Security and Stability
True
True
True
True
Section B (Subjective Type Questions)

Wage employment involves working for employer, receiving a regular fixed salary or Wage
and following the duties and responsibilities given.

Entrepreneurship involves managing one’s own business, taking risks and responsibilities,
earning depends on business success.

The following are the benefits of entrepreneurship:

« Autonomy and independence.



 Potential for higher risks, higher rewards.
 Personal growth and development.
» Opportunity to pursue passion.

3. Risk of business refers to the possibility of incurring losses or failing to achieve desired
outcomes due to uncertainties in the market, competition or other factors.

B. 1. i. Rahulis an Entrepreneur.
ii. Shahid is an Employee.
iii. Ritu is an Entrepreneur.

2. Samira is showcasing Planning, Financial Literacy and Money Management skill.

m Business Activities and Its Types

Unit 4: Entrepreneurial Skills-1

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. ii. To provide products or services that meet customer needs and generate profit
2. ii. Starting and running a new business to make a profit while pursuing a passion or solving
a problem

Section B (Subjective Type Questions)
A. 1. The three main goals of business are:

« Meet Needs: Provide products or services that fulfil the needs or wants of customers.
« Generate Profit: Earn money by selling goods or services to sustain and grow the business.

« Operate Efficiently: Organise resources like money, people and materials effectively for
the smooth operations.

2. The important tasks involved in business activities are:
« Guiding and motivating employees.
« Planning goals and strategies.
« Arranging the resources required.
« Controlling and monitoring the performances.
3. The three business activities are:
+ Product business
 Service business

« Hybrid business
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B. Reena should make conduct a market survey to access the demand for glutin-free product in
the area where are product is sold. She must analyse the costs associated with the production
of the new product and also the capability of het bakery to produce such product.

m Product, Service and Hybrid Businesses

Unit 4: Entrepreneurial Skills-1

ACTIVITY = Page 162

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. i. Seven
2. iii. Partnership
3. ii. Service

B. 1. False
2. True

Section B (Subjective Type Questions)

A. 1. Aproduct based business is one that primarily sells tangible goods. Examples of such business
are:

« A clothing store selling different types of garments.
« A utensil store selling plates, bowls, cookers, mixer grinders etc.

2. Hybrid business is combination of both product-based and service-based businesses.
Examples of such businesses are:
« Arestaurant that sells food products and at the same time they are providing table service.
« A vehicle dealer who sells the vehicle as well as giving repair service.

B. 1. i. Product-based business.

ii. Service-based business.
iii. Service-based business.

2. John s running a product-based business.

3. It varies from person to personal, depending on their preference. I would like to start a
business of selling and exporting handicraft item which are made by the rural people from
biodegradable substances, which will provide earning to the rural population as well as they

get a proper place to sell their finished goods.
fin)
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Entrepreneurship Development Process

Unit 4: Entrepreneurial Skills-1

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. ii. Through learning from their experiences and overcoming challenges
2. ii. The importance of planning and marketing
3. ii. By identifying areas for product refinement

Section B (Subjective Type Questions)
A. 1. The steps of starting a business are:

Step 1: Develop a business plan.
Step 2: Conduct market research.
Step 3: Secure funding.

Step 4: Choose a business structure.
Step 5: Register the business.

Step 6: Set up a business location.
Step 7: Build a team.

Step 8: Market the business.

Step 9: Launch the business.

2. Elon Mask is a successful entrepreneur having visionary leadership, innovative qualities,
risk-taking ability, problem-solving quality and strong work ethic.

B. 1. The steps that should be followed are:

Step 1: Gather customer feedback about the problem with the flavour.
Step 2: Analyse the feedback and identify areas for improvement.
Step 3: Test the new product with a proper feedback giving group.
Step 4: Relaunch the product with the improved flavor.

2. T'would follow the following steps to attract customers:
* Increase the number of selling points.
« Focussuing on customer service.
 Launch loyalty program for existing customers.
« Try to lower the cost.
 Offering deals on big orders.

« Monitoring the competitors price, quality and service, frequently.
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Society and Environment Uit 5: Green Skils-|

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. iii. Replace 2. ii. Sewage and chemical waste discharge
3. ii. Chlorofluorocarbons (CFCs) 4. ii. Tannins

B. 1. Three-fourth 2. Water degradation
3. Protecting the environment 4. Liquefied Petroleum Gas (LPG)

C. 1. True 2. True 3. False 4. True

Section B (Subjective Type Questions)
A. 1. Renewable resources regenerated naturally in a relatively short time. It doesn't affect the
nature and are available continuously. Example of renewable resources are solar, wind, water,
forests etc.

Non-renewable resources cannot be easily regenerated and take millions of years to form.
Their overuse causes long term environmental impact. Example of non-renewable resources
are fossil fuels, minerals etc.

2. Setting up industries leads to pollution of air, water, soil, deforestation, habitat, destruction
and resources depletion due to increased production and consumption.

3. Thelong-term increase heating of the Earth'’s climate system (about 31%) since pre-industrial
period, due to human activities, fossil fuel burning and increases greenhouse gas (CO,, N,O,
O,, CFCs, HCFCs, HFCs) concentrations in the atmosphere is known as global warming.

4. Efficient land management ensures sustainable use, prevent degradation, conserves
biodiversity and supports human needs for food, shelter and resources.

B. Environmental benefit: Solar water heaters use renewable energy, reducing rely on fossils fuels
and lowering greenhouse gas emissions, saves the environment.

Economic benefit: Lower the energy bills in the long run with un-interrupted power supply.

Conserving Natural Resources Unit 5: Green Skills-|

ACTIVITY Page 182

Do it yourself.

Unsolved Exercise .

Section A (Objective Type Questions)

A. 1. ii. It prevents overgrazing and soil degradation
£
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i. Judicious water use

iii. Coal

ii. It maintains optimal lighting efficiency

False 2. True 3. False 4. False
Section B (Subjective Type Questions)

The ways to conserve forests:

 Afforestation (Planting more trees).

+ Preventing deforestation.

 Sustainable forest management (using the forest resources with responsibility).

The ways to conserve water:

« Rainwater harvesting.

- Efficient irrigation techniques (drip irrigation system).

« Watershed management.

The ways to conserve energy:

+ Use energy-efficient appliances.

« Switch off electrical gadgets when not at home or work place.

B. Priya can conserve water by:

Fixing leaky taps promptly.
Taking short showers.
Using bucket instead of a hose for cleaning.

Use the vegetable and fruits washed water for watering plants.

Sustainable Development and Green
Economy Unit S: Green Skills-I

ACTIVITY = Page 187

Do it yourself.

Unsolved Exercise @

A. 1.

2
3.
4

Section A (Objective Type Questions)
i. Uses less resources

ii. Swachh Cooperative and iii. Bio-toilet by Green Solution Foundation
ii. Environmental damage and costs

ii. Improve sanitation
£
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B. 1. Economy
Consumption

Population and income

M owon

Energy-efficient

Section B (Subjective Type Questions)
A. 1. The green jobs are employment opportuinities that contribute preserving or restoring the
environment. They can be in sectors like renewable energy, agriculture, manufacturing, green
building, energy efficiency, forestry, waste management and ecological restoration.

2. Two green projects are:

Waste management: Strategies to prevent resource loss and pollution by separating waste
and implementing the 5R’s- Refuse, Reduce, Reuse, Recycle, Repurpose.

Land management: Using land for various purposes in a way that human needs without
causing environmental harm.

3. The various sectors where green jobs exists are:
 Sustainable agriculture and forestry
+ Construction of green building
« Waste management and recycling
 Ecological restoration and conservation
« Environmental consulting and research
* Renewable energy like solar, wind, hydro
« Providing eco-friendly tourism and hospitality
B. The two points the architect must keep in mind while designing a building are:

Energy efficiency: By maximizing the natural light and ventilation. Using energy efficient building
materials, constructing green buildings.

Water conservation: By implementing rain-water harvesting system, using water efficient fixtures
and design landscape that require minimal irrigation.

f)
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Answer Key o’
Part-B: Subject Specific Skills

m Introduction to IT-ITES Industry

Unit 1: Introduction to IT-ITES Industry

ACTIVITY = Page 196

Do it yourself.

Unsolved Exercise @

Section A (Objective Type Questions)

A. 1. iv. All of these 2. iii. Data-Entry Services
3. iv. All of these 4. ii. Automated Teller Machine (ATMs)
5. iv. Blood Sugar Testing Machine
B. 1. ITES 2. Business process management
3. Indian Service Providers (ISPs) 4. Cardiac Screening
5. Social Networking
C. 1. iii. Alis true but R is false.
2. i. Both A and R are true and R is the correct explanation of A.
3. ii. Both A and R are true but R is not the correct explanation of A.
4. iv. Ais false but R is true.
D. 1. iv.Statement 1 is false, Statement 2 is true.
2. iii. Statement 1 is true, Statement 2 is false.
3. i. Statement 1 is true, Statement 2 is true.
4. iv. Statement 1 is false, Statement 2 is true.

Section B (Subjective Type Questions)
A. 1. The different types of BPO services are:

« Customer support services: Handling customer interactions, inquiries, and support.

« Technical support services: Providing assistance for technical related issues.
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- Data entry services: Managing and inputting data entry students, voters, mortgage etc.
« Accounting services: Handling tasks like payroll, balance sheet, etc.

 Finance and accounting: Managing financial records and transactions.

» Marketing and sales services: Conducting market research and sales activities.

« Human resource services: Support with man power to do different activity in a firm like-
Cleaning, Gardening, Transportation etc.

2. Sectors in which the IT industry is classified are:
« IT in Education
 IT in Banking
« IT in Software development
» IT Insurance
« IT in Marketing
 IT in Healthcare
 Itin Science and Engineering
« IT in Research
« IT in Business
« IT in Entertainment
» IT in Communication
« IT in Social Networking

3. Video Conferencing is a technology that allows users in different locations to hold
face-to-face meetings virtually, using video and audio transmission over the internet.

4. 1IT in healthcare:
« Electronic Health Records (EHRs): To store and manage patient data.
« Telemedicine: To provide remote healthcare services.

« ICT in Diagnosis: Different machines are used for the diagnosis and treatment like ECG
machine, Blood sugar testing machine, MRI machine etc.

« Hospital management systems: To streamline administrative tasks.

« IT in Science, Research and development: For medical advancements.
5. ITin libraries:

- Digital catalogs: To search for books and resources.

« Digital libraries: To access e-books, journals, and databases.

 Internet access: To provide information and research opportunities.

£
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B. 1.
2.

+ Library management systems: To manage inventory and circulation.
¢ Multimedia resources: To offer access to audio and video materials.
Type of BPO service for software installation issue: Technical support (Help desk services).

Communication method for file transfer: File Transfer Protocol (FTP) or cloud storage services.

n Use Keyboard and Mouse for Data Entry

Unit 2: Data Entry and Keyhoarding Skills

'Ab AssiGNMENT ‘N ACTiViTy Page 215

Do it yourself.

Unsolved Exercise @

A 1.
2.
3.
4,
5.
1.
1.
2.
3.
A 1

Section A (Objective Type Questions)
iv. Equal sign (=)
i. Top (M)
iii. Typing special characters and capital letters
iv. Hold the mouse by putting your palm on the body of the mouse
ii. Entering large amounts of numeric data
Net speed 2. Two 3. Alt 4. Function 5. Enter
i. Both A and R are true and R is the correct explanation of A.
i. Both A and R are true and R is the correct explanation of A.

iii. Ais true but R is false.

Section B (Subjective Type Questions)

. The various types of keys on a computer keyboard are:

« Alphanumeric keys: It contains letters from (A to Z or a to z) for entering textual data.

« Numeric keys: Numbers from (0 to 9) for entering different types of numeric values. It
also have mathematical operators also.

« Function keys: These keys from (F1 to F12) performs specific function depending on the
software in which its is being used.

« Punctuation keys: It includes keys for punctuation marks, such as colon (;), semicolon (}),
question mark(?), single quotation mark (' '), double quotation mark (" *), etc.

« Control keys: Keys such as control (Ctrl), Shift, Spacebar, Alt, Caps lock and Tab are special

control keys that perform specific functions depending on when and where they are used.
£
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+ Navigation keys: The keys ( Arrow, Home, End, page UP, Page Down) are used for moving
the cursor.

« Command keys: Keys such as Insert, Delete, Backspace and Enter are command keys.

« Enter key: This key is labelled as Return key. It helps to send the cursor to the next line
and is also used to execute a command.

«  Windows key: Pressing the Windows key on the keyboard the Start menu get activated.
2. The correct position of hands and body while typing are as follows:

« Sit straight with feet flat on the floor or on a footrest.

« Keep wrists straight and relaxed, not bent up or down.

« Position the keyboard directly in front, allowing elbows to be bent at about 90 degrees.

» Maintain a slight gap between the keyboard and the body.

» Keep shoulders relaxed and avoid hunching.

3. Numeric Keypad is a section of the keyboard containing numbers (0-9), a decimal point (.),
arithmetic operators (+, -, *, /), and sometimes an Enter key. It is designed for efficient entry
of numerical data.

4. Guide keys are the key on the keyboard that help touch typists position their fingers correctly
without looking.The guide keys are usually F and J on the QWERTY layout, which have raised
bumps or tactile markings.

5. The role of typing ergonomics are as follows:
« Typing ergonomics aims to maximise comfort, efficiency, and safety while using a keyboard.

« It focuses on the design of the workstation setup, including the keyboard, chair, and
monitor position, to prevent injuries such as carpal tunnel syndrome and muscle strain.

B. Simran can efficiently perform the tasks as follows:

a. Typing Capital Letters: She should use the Shift key to type a single capital letter. Press and
hold the Shift key while pressing the letter key.

b. Adding Symbols: Use the Shift key in combination with number keys to type symbols like
@, %, and $. For example, Shift + 2 for @, Shift + 5 for %, and Shift + 4 for $.

Unit 2: Data Entry and Keyhoarding Skills

'Ab AssiGNMENT ‘N ACTiViTy Page 228-237

Do it yourself.
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Unsolved Exercise 0

Section A (Objective Type Questions)
A.

—_

ii. The completion percentage of the lesson

ii. Pause

iv. Orange colour letters indicate wrong inputs within time
ii. Toolbar

ii. Upload Lesson

Home

Yellow

Keyboard

F.G,RT\V,B4,5- Left index finger

JHY,UM,N,6,7 — Right index finger

A w N =k W

5. Sound control.
C. i. Both Aand R are true and R is the correct explanation of A.

i. Statement 1 is true, Statement 2 is true.

Section B (Subjective Type Questions)
A. 1. Result Interpretation involves analysing the data presented after a typing test or lesson to
understand performance. This includes evaluating speed (WPM), accuracy (error rate), and
other metrics to identify areas of strength and weakness.

2. Inthe Error Overview, different colors are used to represent various types of errors, such as
incorrect characters, extra characters, or missed characters. This color-coding helps users
quickly identify and understand the nature of their mistakes.

3. i. Virtual Keypad: A virtual keypad is a graphical representation of a keyboard on the screen,
allowing users to type using a mouse or touch input.

ii. Lesson Control: Lesson Control refers to the functions that allow users to manage their
typing lessons, such as starting, pausing, restarting, or skipping sections.

iii. Overall Rating: The overall rating is a summary score or evaluation of a user’s performance
in a typing test or lesson, often based on a combination of speed and accuracy.

4. In the text panel of the lesson editor, users can modify the text content of the lessons,
customize the layout, and adjust the formatting to suit their preferences or learning needs.

B. 1. Yash can find the window to start or restart his lesson in the main interface of RapidTyping,
typically labeled as ‘Start Lesson’ or ‘Restart Lesson.’ It may also be accessible through a
menu option like ‘Lesson’ or ‘Course.’

8.0
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2. To check accuracy and speed in a single window, Yashika can follow these steps:
Step 1: Complete a typing lesson or test.
Step 2: Navigate to the ‘Statistics’ or ‘Results’ section.

Step 3: Look for the summary view, which typically displays key metrics such as WPM,
accuracy percentage, and error count in a single window or panel.

m Create a Document using a Word Processor

Unit 3: Digital Documentation

'.Ab AssiGNMENT ‘N ACTIiViTy Page 249

Do it yourself.

Unsolved Exercise @

Section A (Objective Type Questions)
A. 1.iv. All of these.

2. iii. Internet Explorer.

3.iv. Command Prompt.

4. i. The document's name.

1. False 2. True 3. False 4. False 5. False

ii. Both A and R are ture but R is not the correct explanation of A.

Section B (Subjective Type Questions)
A. 1. Components of LibreOffice Writer:

i. Status Bar: Displays information about the current document, such as page number, word
count, and zoom level.

ii. Standard Toolbar: Provides quick access to common functions like saving, opening, and
printing documents.

iii. Title Bar: Displays the name of the current document and application.

2. Default extension of a document in writer is ".odt." The steps to save the document in
LibreOffice Writer:

Step 1: Click on the File option - Save As.

Step 2: Enter the file name and choose the location.

£
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Step 3: Click on 'Save’ button or press enter key.

Step 4: File is saved with the assigned filename.
3. The steps to open an existing document:

Step 1: Click on the File - Open.

Step 2: Locate the file and click on ‘Open.’

B. Kritika should use the ‘Save As’ option to create a copy of the file with a new name.

Apply Editing Features Unit 3: Digital Documentation

'Ab AssSiGNMENT ‘N ACTIVITy Page 257-263

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. i AutoCorrect.

i Ctrl + F7

i. Replaces all occurrences of a word in the document.
i. Ctrl +H

iv. Hash

Not in dictionary 2. Ctrl + F10

vk W

o)
h
—

3. Copy 4. Editing
5. Add to Dictionary

C. 1. False 2. False 3. False 4. True 5. False
1. iii. A'is true but R is false.
2. ii. Both A and R are true but R is not the correct explanation of A.

E. ii. Statement 1 is false. Statement 2 is false.

Section B (Subjective Type Questions)
A. 1. Following are the steps to find and replace a word, phrase or text in LibreOffice Writer:
Step 1: Create a document and write some text or open an existing document.

Step 2: Click on the Edit menu from the Menu bar.
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Step 3: Select the Find and Replace option.

The Find and Replace dialog box opens.

Step 4: Type the text to be searched in the Find combo box.

Step 5: Type the text with which the searched text has to be replaced in the Replace combo

box.

Step 6: Click on the Find Next button to find the matched text. We can also click on the

Find All button to find all instances of the searched text.

Step 7: Click on the Replace to replace the found text.

Step 8: Repeat steps 5 and 6 as many times as required or click on Replace All to replace

all the matching text.

All the possible occurrences of the searched text are replaced with the new text.

Step 9: Once the text has been replaced, click on the Close button to close the Find and

Replace dialog box.

2. Editing means to modify the existing text content. The common editing includes inserting,
deleting, replacing and moving text. It enhances the clarity, accuracy and readability of the
document.

3. The specific keys used for cursor movement and their functions are:

Up Arrow: Moves the cursor up one line.

Down Arrow: Moves the cursor down one line.

Left Arrow: Moves the cursor one character to the left.

Right Arrow: Moves the cursor one character to the right.
Home: Moves the cursor to the beginning of the current line.
End: Moves the cursor to the end of the current line.

Page Up: Moves the cursor up one screen.

Page Down: Moves the cursor down one screen.

Ctrl + Left Arrow: Moves the cursor one word to the left.

Ctrl + Right Arrow: Moves the cursor one word to the right.

4. The different ways to open the Spelling and Grammar dialog box are:

Go to Tools - Spelling from the menu bar.
Press F7 key.
Right-click on a word with a red or blue underline and select ‘Spelling'.

5. The different ways to select non-consecutive text items in Writer using the mouse are:

F)

Click and drag to select the first text item.

Hold down the Ctrl key.
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« Click and drag to select other text items without releasing the Ctrl key.

 Release the Ctrl key once all desired items are selected.

B. Pragya will Copy the text and paste it ten times. Then she will copy all ten lines, and paste the
text ten times to complete 100 times as asked by her teacher.

Apply Formatting Features Unit 3: Digital Documentation

'Ab AssSiGNMENT ‘N ACTIViTy Page 273-295

Do it yourself.

Unsolved Exercise .

A.

N o v W

Section A (Objective Type Questions)
i. 0.79"
iii. View Menu
iii. Insert
ii. The image is linked and any changes to the source will be reflected in the document
iii. Alt +3

i. Using the handles around it

i. Orientation
Portrait 2. Ctrl +1 3. Graphics 4. Page Break 5. 05cm
True 2. True 3. True 4. False 5. True

ii. Both A and R are true and R is the correct explanation of A.
i. Both A and R is true and R is the correct explanation of A.
iv. Ais false but R is true.
Section B (Subjective Type Questions)
Graphics refers to any visual elements that can be inserted into a document.
Paragraph spacing is the amount of space above and below a paragraph.
The steps to insert a special symbol are:
Step 1: Click where the symbol is to be inserted.
Step 2: Go to the ‘Insert’ tab.
Step 3: Click ‘Symbol’ then select 'More Symbols.’

Y
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Step 4: Choose the desired symbol and click Insert.’

4. Header and Footer are sections at the top and bottom of a document page, which are often
used to place page numbers, titles, and dates.

5. The steps to modify line spacing are:
Step 1: Select the paragraph(s).
Step 2: Go to the 'Home' tab.
Step 3: Click the ‘Line and Paragraph Spacing’ button.
Step 4: Choose the desired line spacing.
6. Different ways to change font color are:

« Select the text, click the arrow next to the ‘Font Color’ button in the 'Home' tab, and
choose a color.

OR
+ Select the text, right-click, and choose a color from the font color options.

B. Vineet should use the ‘Bulleted or Numbered’ list feature in Writer to organize his shopping list.

mCreiand Work With Tables Unit 3: Digital Documentation

'.Ab AssiGNMENT ‘N ACTiViTy Page 307

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)
A. 1. ii. Tablemenu - Merge Table option

2. iv. All of these

3. ii. Ctrl + Home

4. ii. Ctrl + X

5. iii. Click inside the cell
B. 1. False 2. True 3. False 4. True 5. False
C. 1. ii. Both A and R are true and R is the correct explanation of A.

2. iii. Alis true but R is false
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D. 1. iii. Statement 1 is true. Statement 2 is false.
2. iii. Statement 1 is true. Statement 2 is false.
Section B (Subjective Type Questions)
A. 1. The steps to insert columns in a table are:
Step 1: Click in a cell to the right or left of where the new column should appear.
Step 2: Right-click, go to ‘Column’ and select ‘Insert Columns Left’ or ‘Insert Columns Right'.
2. The ‘Insert’ button in the Table toolbar allows quick insertion of rows or columns.
3. Select the table, then click and drag it to the desired location.
4. The steps to create a table using the Insert Table dialog box are:
Step 1: Click on Table menu — Insert Table option.
Step 2: Specify the number of columns and rows.
Step 3: Click on Insert button.

5. Merging tables combines two or more tables into a single table that is useful for consolidating
related data.

B. 1. The Table feature of LibreOffice Writer provides the facility to organize the rough information
of Gaurav.

2. To add an additional column for ‘Battery Life’ follow the given steps:

Step 1: Right-click on a cell and go to ‘Column’.

Step 2: Select 'Insert Columns Left’ or ‘Insert Columns Right' wherever required.
3. To combine two separate tables follow the given steps:

Step 1: Select one of the tables.

Step 2: Drag and drop it next to the other table.

Step 3: Then, select both tables and click Table > Merge Tables.

n Use Print Options Unit 3: Digital Documentation

Unsolved Exercisc @
Section A (Objective Type Questions)

A. 1. ii. Aprinter
2. ii. Select the 'Pages’ radio button and specify the range (e.g. 2-10)
3. ii. It opens the Print dialog box

&R

( Y

>>>>>>>>>>>>>>. Touchpad IT 402 (Ver. 4.0)-IX (Answer Key) 41



True 2. True 3. True 4. True
Both A and R ane true and R is the correct explanation of A.
Statement 1 is true. Statement 2 is false..
Section B (Subjective Type Questions)
The steps to print only the specific pages from a document are:
» Click on File menu - Print option.
+ In the print dialog box, specify the page numbers to print in the 'Pages’ field.
To print multiple non-continuous pages follow the given steps:
 Click on File menu - Print option.

 Inthe print dialog box, enter the page numbers separated by commas in the ‘Pages’ field
(eg.1,3,57).

To select a different printer to print the document:
+ Click on File menu - Print option.

 In the Print dialog box, use the Printer drop-down list to choose the desired printer.

B. Awadhesh should use the ‘Print Preview’ feature in LibreOffice Writer to see how the document
will appear on paper before printing.

m Understand and Apply Mail Merge

Unit 3: Digital Documentation

Unsolved Exercise @

A1
2.
3.
4.
B. 1
3.
5.
C 1
1.
2.
£

Section A (Objective Type Questions)
ii. Mail Merge
iii. Select Address List dialog box
ii. Create Salutation
i. Edit individual document
Address Block 2. Customized Address List
Adjust layout 4. Mail Merge
Save merged document
True 2. False 3. True 4. False 5. True 6. True
Both A and R are true and R is the correct explanation of A.

A is false but R is true.
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E. 1. Statement 1 is true. Statement 2 is true.
2. Statement 1 is false. Statement 2 is true.
Section B (Subjective Type Questions)

A. 1. A data source is a file or document that contains (names and addresses) the personalised
information that is to be merged into the main document.

2. The options available for selecting a starting document in Mail Merge are:
+ Use the current document.
+ Create a new document.
« Start from a template.
« Start from an existing document.
3. The key steps to print merged documents are:
Step 1: Click on 'Print merged documents’ from Mail Merge toolbar.
The Print merged document dialog box appears.
Step 2: Select Printer from drop down list.

Step 3: Select the desired radio button in the Print Records section to print the merged
document

Step 4: Click on the 'Print Documents’ button. The merged document will be printed.

4. Recipients can be excluded from the Mail Merge process by deselecting the reciepient from
the address list.

5. Steps to send email messages in Mail Merge:
Step 1: Open a Word document and go to the ‘Tools’ menu ‘Mail Merge Wizard'.
Step 2: Click 'Select Starting Document” and select ‘Use the current document’.
Step 3: Select 'Document Type'.

Step 4: Select recipients by choosing ‘Select Address List" and either typing a new list, using
an existing list.

Step 5: Create Salutation and Adjust the layout if required.
Step 6: Edit Individual Address if required.
Step 7: Finish by clicking ‘Finish & Merge'.

B. 1. To structure the data for the library notices, create a spreadsheet with columns for patron
name, overdue book titles, and due dates. In the Mail Merge main document, use merge
fields to insert this information into the notice template.

2. Manohar can use Mail Merge to create the wedding invitations.

8.0
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create a Spreadsheet Unit 4: Electronic Spreadsheet

'.Ab AssiGNMENT ‘N ACTIiViTy Page 336-341

Do it yourself.

Unsolved Exercisc @
Section A (Objective Type Questions)

A. 1. iii. To perform calculations and display information
2. iii. File
3. ii. Vertical Range
4. i. 1024
5. ii. A5
1. True 2. False 3. True 4. True 5. True
1. i. Both A and R are true and R is the correct explanation of A.
2. ii. Both A and R are true but R is the correct explanation of A.

Section B (Subjective Type Questions)
A. 1. The steps to hide a sheet in a spreadsheet are:

Step 1: Click the sheet menu.
Step 2: Select 'Hide Sheet’ from the context menu.
2. To add a new sheet to your spreadsheet follow the given steps:

Step 1: Click the "+’ button next to the last sheet tab.

OR
Step 2: Right-click on any sheet tab and select 'Insert Sheet'.

3. The steps to rename a sheet are:
Step 1: Double-click on the desired sheet from the Sheet tab .
Step 2: Type the new name and press Enter key.

4. A cell range is a group of two or more cells on a sheet. Ranges are identified by the cell
addresses of the first and last cells in the range, separated by a colon (e.g., B1:C15).

5. The steps to delete a sheet from the spreadsheet:
Step 1: Right-click on the sheet tab to be deleted.

Step 2: Select ‘Delete Sheet’ from the context menu.

=)
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Step 3: Confirm the deletion.
Step 4: The sheet get deleted.
The company will prefer a spreadsheet software like LibreOffice Calc or Microsoft Excel.

The cell address is E9.

m Applying Formula and Functions in Spreadsheet

Unit 4: Electronic Spreadsheet

'.Ab AssiGNMENT ‘N ACTiviTy Page 352

Do it yourself.

Unsolved Exercise @

A 1
3.
5.
1.
iii.

A. 1
2.

Section A (Objective Type Questions)

ii. MAX() 2. iv. #NUM!

ii. Formula 4, ii. Ctrl+V

iv. All of these.

True 2. False 3. False 4. False 5. True

Ais true but R is false.

Section B (Subjective Type Questions)
The list of errors that commonly occur in Calc and reason for occurrence are as follows:
« #DIV/0!: Occurs when a formula is divide by zero or an empty cell.

« #NAME?: Appears when Calc doesn't recognize text in a formula, often due to missing
quotation marks.

«  #VALUE! Shows up when a formula has the wrong type of argument, like trying to multiply
text with a number.

« #REF!: When a cell reference in a formula is not valid, usually when a referenced cell was
deleted.

e #NUM!: Occurs with invalid numeric values in a formula, like trying to calculate the square
root of a negative number.

o ###: Occurs when the cell contains a number, date or time that is wider than the cell width.
i. MAX(): Returns the largest value from in a set of numbers.
ii. AVERAGE(): Calculates the arithmetic mean of a set of numbers.

iii. COUNT(): Counts the number of cells in a range that contain numbers.
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3. The differences between the OR and AND logical functions are:
« AND returns TRUE if all conditions are TRUE, otherwise, it returns FALSE whereas,

+ OR returns TRUE if at least one condition is TRUE, it returns FALSE only if all conditions
are FALSE.

4. The difference between formula and function:

« A formula is an expression that calculates a value, starting with an equals sign (=) and
can include functions, operators, and cell references.

« A function is a predefined formula in a spreadsheet program that performs a specific
calculation.

5. Aformula is an expression that calculates a value. It begins with an equals sign (=) followed
by cell references, values, and operators.

Example:=A15+B16 adds the values in cells A15 and B16.

B. 1. To calculate the percentage of total sales from a particular region, the formula should be
=D2/D10*100

2. Total Expenses =SUM(B2:B6) which will result in 11,500
Remaining Budget =B1-SUM(B2:B6) which will result in 8.50

m Format Data in the Spreadsheet

Unit 4: Electronic Spreadsheet

'Ab AssiGNMENT ‘N ACTiViTy Page 369

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. iii. Numbers

ii. Format

ii. Enhance readability and presentation

ii. PressCtrl +B

iv. Distributed

i. Font size is reduced to fit within the column width.

ii. Use the Number tab.

©® N o v oA W DN
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iii. Top
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1. Format 2. Distributed 3. Height 4. Format
1. i. Both A and R are true and R is the correct explanation of A.
2. iii. Ais true but R is false.
D. iii. Statement 1 is true. Statement 2 is false.
Section B (Subjective Type Questions)
A. 1. To apply the Fill Handle for a number series follow the given steps:
Step 1: Select the cell containing the starting number.

Step 2: Hover the cursor over the small square at the lower-right corner of the cell (the Fill
handle tool).

Step 3: Click and drag the Fill Handle down or across to get the desired range.
Step 4: Release the mouse button, and the series will be filled.
2. The uses of the Alignment tab in the Format Cells dialog box is to:
+ Control the horizontal and vertical alignment of text within a cell.
« Adjust text orientation and indentation.
«  Wrap text to fit within the cell.
« Merge cells together.
3. The way to format a spreadsheet cell to hold a date is:
Step 1: Select the cell(s) to format.
Step 2: Right-click and choose 'Format Cells'.
Step 3: Go to the 'Number' tab.
Step 4: Select 'Date’ from the category list.
Step 5: Choose the desired date format.
Step 6: Click on 'OK'’ button.
4. The steps to copy a formula using the Copy-Paste method is:
Step 1: Select the cell containing the formula.
Step 2: Copy the cell (right-click and choose '‘Copy’ or press Ctrl+C).
Step 3: Select the cell(s) where the formula should be copied.
Step 4: Paste the formula (right-click and choose ‘Paste’ or press Ctrl+V).
5. The steps to format a cell to hold time is:
Step 1: Select the cell(s) to format.
Step 2: Right-click and choose 'Format Cells’.

8.0
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Step 3: Go to the ‘Number' tab.
Step 4: Select ‘'Time' from the category list.
Step 5: Choose the desired time format.
Step 6: Click on 'OK'’ button.

B. 1. Tina will follow the following steps:
Step 1: Select the cells containing the amounts.
Step 2: Right-click and choose 'Format Cells'.
Step 3: Go to the ‘Number' tab.
Step 4: Select ‘Number’ from the category list.
Step 5: In the ‘Decimal places’ box, enter ‘2'.
Step 6: Click on 'OK'’ button.

2. Ravi will follow the following steps:

Step 1: Select the cell containing ‘Science Class'.
Step 2: Right-click and choose 'Format Cells'.
Step 3: Go to the 'Alignment’ tab.
Step 4: Under 'Horizontal’ and select ‘Center’.
Step 5: Under 'Vertical’ and select ‘Center’.

Step 6: Click on 'OK’ button.

m Understand and Apply Referencing

Unit 4: Electronic Spreadsheet

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. i. =$A2*B$2

2. ii. To lock the row or only the column while copying the formula
B. 1. Fixed

2. B$10
C. i. Both Aand R are true and R is the correct explanation of A.

Section B (Subjective Type Questions)

A. 1. Cell referencing in spreadsheets is the way to refer the formula or function of one cell to
other cell along the row or column.

£e
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Relative referencing is the default type of referencing in LibreOffice Calc. It means that when
you copy a formula from one cell to another, the cell references in the formula change
according to their relative position.

Aarav can use absolute referencing in G2 and keep Total marks row relative.

=(E2/$G$2)*100

Create and Insert Different Types of Charts
in a Spreadsheet

Unit 4: Electronic Spreadsheet

Unsolved Exercise @

A 1.

oA W

—_

Section A (Objective Type Questions)
iv. Legend
ii. Pie chart
iii. X-Y (Scatter) Chart
ii. Area Chart
ii. The value of each item in proportion to the total value.
False 2. True 3. True 4. False 5. True
i. Both A and R are true and R is the correct explanation of A.
iii. Ais true but R is false.

Section B (Subjective Type Questions)

Charts are useful for decision-making because they provide a visual representation of data,
making it easier to identify trends, patterns, and outliers. This allows for quicker and more
informed decisions compared to analyzing raw data alone.

The primary difference between a line chart and an area chart is that a line chart displays
data points connected by lines, showing trends over time or categories, while an area chart
fills the space between the line and the axis, emphasizing the magnitude of change or the
volume of data.

A chart title is a descriptive label for the chart that explains what the chart is about. It is
important because it provides context for the data and helps viewers understand the chart’s
purpose and content quickly.

Gridlines are lines that run across the chart's plot area, both horizontally and vertically. Their
purpose is to make it easier to read and interpret the data accurately by providing visual
reference points for the values.
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B. A bar chart or column chart would be suitable for comparing profit per commodity sold. This
type of chart allows for easy comparison of discrete categories (commodities) based on a single
variable (profit).

Understand Features of an Effective
Presentation

Unit S: Digital Presentation

Unsolved Exercise @

A.

£

Section A (Objective Type Questions)
iii. Ensuring a logical flow of topics
ii. 5-8
Potential Elements
Distract
iv. A is false, but R is true.
i. Both A and R are true and R is the correct explanation of A.

Section B (Subjective Type Questions)

Font size impacts readability and hierarchy. Larger fonts are used for titles and emphasis,
while smaller fonts are used for body text. Consistent and appropriate font sizes ensure the
audience can easily read and understand the information.

Few characteristics of a good presentation are:
+ Clear and concise content.

 Visually appealing design.

+ Logical flow of information.

« Engaging delivery.

+ Appropriate use of visuals.

« Effective use of font sizes and styles.

Adding four videos to a single slide could negatively impact the effectiveness of Sonam'’s
presentation. It could effect in the following ways:

Overwhelm the audience: Too much visual information at once can be distracting and make
it difficult for the audience to focus on the key message.

Slow down the presentation: Loading and playing multiple videos might cause technical
issues or delays, disrupting the flow of the presentation.
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» Reduce engagement: If the videos are too long or not relevant, the audience may lose interest.

« Decrease clarity: Multiple videos might create a cluttered slide, making it hard for the audience
to understand the main point.

It would be more effective to use one well-chosen video or spread the videos across multiple
slides with clear context and explanations.

Create a Presentation Unit S: Digital Presentation

'Ab AssiGNMENT ‘N ACTiViTy Page 410

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. iv. All of these

2. ii. View - Slide Layout
3. ii. Ctrl + Shift + S

4. i. Select

5. ii. Slide

B. 1. Presentation

2. Slide pane
3. Workspace
4. Find and Replace
5. Standard
C. 1.i.Both A and R are true and R is the correct explanation of A.

2.ii. Both A and R are true but R is not the correct explanation of A.

Section B (Subjective Type Questions)
A. 1. The Drawing toolbar in Impress provides tools for creating and editing shapes, lines, and
other graphic elements directly on the slides. It allows users to add visual elements to their
presentations, enhancing their appearance and conveying information effectively.

2. Window control buttons are used to manage the application window. They are located in
the top-right corner of the window. The following are the Windows control button:

« Minimize: Reduces the window to a taskbar icon.
2
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« Maximize/Restore: Enlarges the window to fill the screen or returns it to its previous size.
 Close: Exits the application.

3. The Animation Deck, or Animation pane, is a feature that allows users to add and customize
animations and transitions for elements within a slide. It enables control over how objects
appear, move, or disappear during a slideshow, adding visual interest and emphasis.

4. Aslide show is a presentation of a series of slides displayed in sequence, which are used to
present information to an audience. It can include text, images, animations, and transitions,
and is commonly used in business meetings, educational settings, and public speaking events.

5. A template in Impress is a pre-designed layout that serves as a starting point for creating
presentations. Templates provide a consistent design, including background styles, font
schemes, and placeholder arrangements, which can save time and ensure a professional
look.

B. 1. Indushould export the presentation in HTML format to allow it to be viewed in a web browser.

2. Sanju can close the presentation without exiting LibreOffice Impress by clicking the ‘Close’
button on the specific presentation window or using the shortcut Ctrl + W.

Work With Slides Unit 5: Digital Presentation

'.Ab AssiGNMENT ‘N ACTiviTy Page 421

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)

A. 1. i. Normal view
2. i. Undo
3. dii. Ctrl + Y
4. iv. Outline
5. ii. The background and common elements for all slides.
B. 1. Ctrl 2. Copying
3. Delete Slide option and Delete 4. Ctrl+ M
5. Normal
C. 1. i. Both A and R are true and R is the correct explanation of A.
2. ii. Both A and R are true but R is not the correct explanation of A.
)
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iii. Ais true but R is false.
i. Statement 1 is true, Statement 2 is true.

iv. Statement 1 is false, Statement 2 is true.

Section B (Subjective Type Questions)

i. Copy aslide Ctrl + C
ii. Reverse the last change Ctrl + Z
iii. Paste the slide Ctrl + V

The Zoom Control slider is used to zoom in or out of the current view of the slide.

The Slide Sorter View is used to see all the slides in a presentation at once, which is useful
for rearranging the order of slides, adding or deleting slides, and getting an overview of the
entire presentation.

Shivani is currently viewing the presentation in Outline View. In this view, only the text content
of the slides is visible, while graphical elements are hidden.

The name of the company can be added to the top of each slide in the Master Slide view.
This can be accessed through the View menu.

Ravi should use Normal View in LibreOffice Impress to view and edit the content of his slides
easily. This view allows him to see both text and graphical elements and make changes as
needed.

Raj should use Slide Sorter View to review and rearrange his slides. He can add personal
notes in the Notes Pane, which is located below the slide view in Normal View. These notes
will not be visible during the presentation.

Anika can use the Undo feature (Ctrl + Z) in LibreOffice Impress to reverse her last action
and restore the deleted text box immediately.

m Format Text and Apply Animation

Unit S: Digital Presentation

Unsolved Exercise .

A. 1

vk W

Section A (Objective Type Questions)
ii. Aligns the text to the right margin
i. Clear Direct Formatting
ii. Lists
iii. Entrance Effects

iii. Visually separate blocks of text
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6. iii. Toggle Ordered List
7. ii. Fade
B. 1. Line spacing 2. Emphasis 3. Superscripted 4. Normal
5. Bullets, Numbers
C. 1. iv. Ais false but R is true.
2. ii. Both A and R are true but R is not the correct explanation of A.
Section B (Subjective Type Questions)

A. 1. Animation refers to the process of creating the illusion of movement by displaying a sequence
of static images in quick succession.

2. The steps to apply a number list style to text in a slide are:
Step 1: Select the text.
Step 2: Go to the 'Format’ menu or the formatting toolbar.
Step 3: Choose 'Bullets and Numbering'.
Step 4: Select the 'Numbering' tab.
Step 5: Choose a number list style and click on ‘OK’" button.

3. Bulleted lists use symbols to highlight items without indicating sequence, while numbered
lists use numbers to show the sequence.

« To apply bullet, select the text, go to ‘Bullets and Numbering’ and choose the desired
style (bullet or numbering).

4. Entrance effects control how an object appears on a slide, while exit effects determine how
it disappears from the slide.

5. The steps to remove animations are:
Step 1: Select the animated object.
Step 2: Go to the ‘Animations’ pane.
Step 3: Select the animation effect.
Step 4: Click 'Remove’ or the ‘Delete’ icon.
B. 1. Toimprove readability and enhance visual appeal, Dev can use:
« A consistent font style and size throughout the presentation.
« Adjust the line spacing and alignment to increase readability.

2. Nikita should use an exit effect like 'Fade Out’ or ‘Fly Out'.

f)
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mﬂe and Use Tables

'Ab AssiGNMENT ‘N ACTiViTy Page 446

Do it yourself.

Unsolved Exercisc @
Section A (Objective Type Questions)

A. 1. iii. Drag the column borderline left or right

2. iii. Bothi. and ii.

3. i. Border Color button in the Table toolbar

4. iv. All of these
B. 1.False 2. False 3. True 4. True
C. 1. i. Both A and R are true and R is the correct explanation of A.

2. iv. Ais false but R is true.

Section B (Subjective Type Questions)

Unit S: Digital Presentation

A. 1. Customising table borders can enhance the visual look of a table, making it more organised
and easier to read. It helps in differentiating data and improves the overall presentation.

2. The steps to change the background of a table are as follows:
Step 1: Select the table.
Step 2: Right-click on the table.
Step 3: Choose ‘Table Properties'.
Step 4: Go to the ‘Background’ tab.
Step 5: Select a color or fill style.
Step 6: Click on 'OK'’ button.

3. The steps to change the height of a row in a table are as follows:

Step 1: Select the row to change height.
Step 2: Right-click on the row.

Step 3: Choose 'Row’ and then 'Height'.
Step 4: Enter the desired height.

Step 5: Click on ‘OK' button.

B. Raman would follow the following two ways to delete a table from his slide:

i. Select the table and press the ‘Delete’ key from keyboard.

ii. Right-click on the table and choose 'Delete Table’ from the context menu.

DI2OIIIPPP000) Toueped T 402 Ve 407X v k) 35,

¥



m Insert and Format Image in Presentation
Unit S: Digital Presentation
'.Ab AssiGNMENT ‘N ACTIiViTy Page 455-459

Do it yourself.

Unsolved Exercise @
Section A (Objective Type Questions)
A. 1. ii. Select the slide

2. ii. Afour direction arrow

3. iii. Bothi. and ii.

4. i. Drawing

5. i. Resizing Image

6. iii. Ctrl + Alt + Shift + G

1. Media 2. Themes 3. Selection handles 4. Ctrl + Shift + G

1. i. Both A and R are true and R is the correct explanation of A.

2. i. Both A and R are true and R is the correct explanation of A.
D. 1. ii. Statement 1 is false. Statement 2 is false.

2. i. Statement 1 is true. Statement 2 is true.

3. iii. Statement 1 is true. Statement 2 is false.

Section B (Subjective Type Questions)
A. 1. The steps to rotate an image on a slide are as follows:
Step 1: Select the image to rotate.
Step 2: Go to the 'Format’ menu or the ‘Image’ menu.
Step 3: Choose 'Rotate’ or ‘Flip'.

Step 4: Select the desired rotation option (e.g., rotate left, rotate right, flip horizontal, flip
vertical).

2. The process of moving an image on a slide are as follows:
Step 1: Select the image to move.
Step 2: Click and hold the mouse button on the image.
Step 3: Drag the image to the desired location on the slide.

Step 4: Release the mouse button.
£
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3. The different operations that can be done on an image are:

+ Resizing + Rotating
+ Flipping « Cropping
« Changing the order +  Grouping

4. The steps to add an image from the Gallery are as follows:

5.

Step 1: Open the Gallery from the sidebar or from the ‘View' menu).
Step 2: Browse through the categories or search for an image.

Step 3: Click on the image you want to add.

Step 4: Drag the image onto the slide or right-click and select 'Insert'.
The steps to group drawing objects are as follows:

Step 1: Select the drawing objects you want to group (hold Shift or Ctrl while clicking to
select multiple).

Step 2: Right-click on one of the selected objects.

Step 3: Choose ‘Group’ from the context menu.

B. Amit can resize the image to exactly 5 cm wide and 7 cm tall by the following steps:

Step 1: Selecting the image.

Step 2: Right-clicking the image and selecting 'Properties’ or ‘Format’.

Step 3: Going to the ‘Size’ or ‘Position and Size' tab.

Step 4: Unchecking ‘Keep ratio’ or ‘Lock aspect ratio’ to adjust width and height independently.

Step 5: Entering '5 cm’ in the width box and ‘7 cm’ in the height box.

Step 6: Clicking on 'OK’ button or ‘Apply’ button.

Work With S“de Master Unit S: Digital Presentation

Unsolved Exercise @

A. 1

w N

Section A (Objective Type Questions)

iii. Inserts an image as the slide background

iv. Advanced

ii. View

True 2. True 3. False

i. Both A and R are true and R is the correct explanation of A.
iv. Ais false but R is true.
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Section B (Subjective Type Questions)
A. 1. Slide Master is a feature that controls the overall design and layout of slides in a presentation,
while Slide Transition refers to the visual effects that occur when moving from one slide to
the other.

2. Play button is used to preview the transition effect.

B. To rectify the slow and disruptive transition effect, Seema can adjust the transition speed or
duration in the slide transition settings. She can also choose a different, less distracting transition
effect.

£
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